Contents

Who to call.........................................................................................................................1

Kroll Passwords..................................................................................................................1

Technician User Account Setup............................................................................................3

Associating Pharmacists with Technicians...........................................................................4

Patient Allergies/Intolerances..............................................................................................6

Adding a Patient Allergy/Intolerance.................................................................................. 6
Deleting a Patient Allergy/Intolerance.................................................................................. 12
Deleting a Patient Allergy/Intolerance that has a note recorded on the network................. 14
Synchronizing Network Allergies to the Local Kroll System............................................... 19
Adding an Intolerance to an Existing Allergy Group............................................................. 22
Supporting Information.........................................................................................................26
Reported Reactions ..............................................................................................................28
Allergy Tests ........................................................................................................................31
Retrieving Allergy Information from PIP ..............................................................................33
Viewing Allergy Details from PIP .........................................................................................35
Extra Functions from the Allergies Profile...........................................................................36
Synchronize ..........................................................................................................................38
Unsynchronize .......................................................................................................................38
Retracting an Allergy ...........................................................................................................39
Add Allergy/Intolerance Note ...............................................................................................41
Get Allergy/Intolerance History............................................................................................43

Network Options from the Patient Card...............................................................................46

Profile .................................................................................................................................46
Not Dispensed Profile.........................................................................................................50
Add Consent .........................................................................................................................52
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filling a Mixture Rx</td>
<td>128</td>
</tr>
<tr>
<td>Transferring an Rx to another Pharmacy</td>
<td>132</td>
</tr>
<tr>
<td>Filling an Rx using an Natural Product Number (NPN)</td>
<td>133</td>
</tr>
<tr>
<td>Filling an Rx for an Animal</td>
<td>135</td>
</tr>
<tr>
<td>Filling an Rx for Out-of-Province Patient</td>
<td>135</td>
</tr>
<tr>
<td>Filling an Rx for an Out-of-Province Doctor</td>
<td>136</td>
</tr>
<tr>
<td>Filling an Rx for Stock Transfers</td>
<td>137</td>
</tr>
<tr>
<td>Filling an Rx for a Drug not on PIP</td>
<td>137</td>
</tr>
<tr>
<td>Filling an Rx that is rejected by PIP</td>
<td>137</td>
</tr>
<tr>
<td>Refilling an Rx without PIP</td>
<td>137</td>
</tr>
<tr>
<td>Prescription Vial Labels</td>
<td>138</td>
</tr>
<tr>
<td>Indications</td>
<td>139</td>
</tr>
<tr>
<td>Sending Indications to the Network</td>
<td>139</td>
</tr>
<tr>
<td>Retrieving Indications on the Network</td>
<td>140</td>
</tr>
<tr>
<td>Prescription Pickup</td>
<td>141</td>
</tr>
<tr>
<td>Automatic Pickup</td>
<td>141</td>
</tr>
<tr>
<td>Manual Pickup</td>
<td>141</td>
</tr>
<tr>
<td>Retrieving Picked Up Status from the Pharmacy Network</td>
<td>143</td>
</tr>
<tr>
<td>Undo Pickups</td>
<td>144</td>
</tr>
<tr>
<td>Reports</td>
<td>147</td>
</tr>
<tr>
<td>Patient Network Audit Report</td>
<td>147</td>
</tr>
<tr>
<td>Failed Provincial Claims Flat File Report</td>
<td>148</td>
</tr>
<tr>
<td>What Happens When PIP Goes Down</td>
<td>150</td>
</tr>
<tr>
<td>Printing Labels for Dispensing when PIP is Down</td>
<td>151</td>
</tr>
<tr>
<td>Kroll Helpdesk Information</td>
<td>154</td>
</tr>
<tr>
<td>Head Office – Toronto</td>
<td>154</td>
</tr>
</tbody>
</table>
Western Canada – Edmonton .............................................................. 154
Eastern Canada – Dartmouth .............................................................. 154
Saskatchewan Pharmacy Network

The Saskatchewan Health Information Network (SHIN) is managed by the Health Information Solutions Centre (HISC). SHIN is committed to maintaining a provincial Electronic Health Record (EHR) that will facilitate the sharing of health related data between medical professionals such as doctors, pharmacists, nurses, etc. The Pharmaceutical Information Program (PIP) is a component of the EHR.

Today, every prescription that Saskatchewan residents receive is captured and stored on the Pharmaceutical Information Program (PIP). PIP is available to all community pharmacies and contains information on over 45 million prescriptions. The province is currently incorporating PIP into the pharmacy software systems used by community pharmacies so that users do not have to rely on the PIP viewer to access prescription information.

PIP manages medication information in the province. The primary goal of PIP is to improve the quality of patient care by providing the information and tools needed to make optimal drug therapy decisions. For more information on PIP please visit http://www.health.gov.sk.ca/pip.

Kroll Computer Systems Inc. has been coordinating closely with SHIN and PIP to develop software that supports security, privacy and conformance standards set out by HISC. Kroll is an authorized Pharmacy Practice Management System (PPMS). The following user guide provides instructions on how to navigate the Pharmaceutical Information Program (PIP) in Kroll.

Who to call?

For any issues or errors, please contact the Kroll Support desk who will determine if this is an ADAPT issue or a PIP issue.

Kroll Passwords

In conformance with Pharmaceutical Information Program (PIP) standards, Kroll passwords must be complex and meet the following requirements:

- Passwords must be at least 8 characters long (10 characters for administrator users);
- Passwords must contain lower and upper case characters;
• Passwords must contain at least two numeric characters and one symbol character. (!,@,#,$,%,^,&,*).

An example of a password that meets conformance is “Password!23”.

Password security requirements are hardcoded into versions of Kroll that support PIP integration. Additional hardcoded password configurations include the following:

• Password must be changed every 60 days;
• Prevent usage of 10 previously used passwords;
• Disable user after 3 failed login attempts;
• Username and Password must be re-entered after 30 minutes on inactivity on the screen;
• Users cannot change their password more than once per day to prevent circumventing the restriction that prevents re-using previous passwords;
• An initial password change is forced for new users logging in for the first time.

Password security settings can be made more restrictive and can be found in File > Configuration > Store > Security.
Technician User Account Setup

In order for pharmacy technicians to access and send transactions to PIP, they require a Common Provider Number (CPN) to be entered in their Kroll user account. The CPN is provided to the technician once PIP registration has been approved. The CPN is a unique identifier used within the Provider Registry system (the same system which contains doctor billing/license numbers) to help correlate and trace the activity of a particular account; the CPN is NOT used to assign user permissions.

Enter a CPN number (one time only) for a technician account as follows:

1. Go to Edit > Users and Groups.
2. Log in with your user initials and password to open the Edit Users and User Groups window.
3. Double-click on the technician entry, or highlight the entry and press F2 on the keyboard to access the User Information screen.

4. Locate the Technician ID field and input the CPN number. The CPN number is in the format CPN.XXXXXXXX.SK.PRS, where “X” is a number.
5. Click **Save** or press **Enter** on the keyboard to save the CPN number to the technician account.

6. Click **Close** or press **Esc** on the keyboard to exit from the **Edit Users and User Groups** screen.

---

### Associating Pharmacists with Technicians

Pharmacy technicians cannot access PIP without associating to a pharmacist because a license number is required for the retrieval of patient medical information. When a technician is associated with a pharmacist, **the pharmacist must be aware that any network profile requests initiated by the technician will be authored by the associating pharmacist’s license number.**

Associate a technician to a pharmacist in Kroll as follows:

1. Go to **File > Users > Associate Pharmacist** to call up the Pharmacist Association Form.
   
   a. **Pharmacist Initials**: Enter the initials of the pharmacist that is associating with the technician(s).
   b. **Password**: Enter the associating pharmacist’s password.
   c. **Association Expires today at**: Enter the military time that the association expires (e.g. if the pharmacist’s shift ends at 5pm, the value in this field should be 17:00).

   **NOTE**: Pharmacist associations cannot be extended beyond 24 hours, and will automatically disassociate at 23:59 daily unless specified for an earlier time.

2. Flag technicians that need to be associated (more than one technician can be flagged at once).
3. Click **Associate** or press **Enter** on the keyboard to associate the pharmacist to the technician(s).

**NOTE:** A pharmacist can choose to disassociate from a technician(s) at any time by going into **File > Users > Disassociate Pharmacist** and entering their user initials and password. Once the technician(s) is disassociated, they will not be able to send or receive information to or from PIP until another pharmacist associates with them.
Patient Allergies/Intolerances

Recording patient allergies and intolerances on PIP is an integral part of creating a comprehensive Electronic Health Record (EHR) for Saskatchewan residents. The availability of this information allows pharmacists and other health care professionals make optimal drug therapy decisions. The following section describes how to add allergies/intolerances to PIP, and how to retrieve them through Kroll.

Adding a Patient Allergy/Intolerance

When patient allergies are added locally on Kroll, the information is sent and recorded on PIP. Add a patient allergy as follows:

1. Bring up the patient card using the F3 Patient search.

2. From the Allergies section of the patient card, click Ins or press Insert on the keyboard.

3. Search for an allergy from the Select an Allergy screen and click Search or press Enter on the keyboard to obtain results (e.g. Type “macrol” to search for a Macrolide allergy).

**NOTE:** Options are available to query the search string by “Starts with” or “Contains”.

![Select an Allergy Screen](image-url)
4. Select the **Allergy Group** by highlighting the entry and clicking **Select** or pressing **Enter** on the keyboard. This will bring up the **Patient Allergy Information** form.

![Select an Allergy](image)

**NOTE:** PIP supports the addition of **Allergy Groups** and NOT specific **Medications** or **Ingredients**. If a **Medication** or **Ingredient** is selected as an allergy, the following warning will appear:

![Alert](image)

5. From the **Patient Allergy Information** form, fill out the **Source**, **Date** and **Apply to Allergies** fields. Enter an OPTIONAL **Comment** regarding the nature and severity of the allergy (comments entered in this field are stored locally on Kroll, not on PIP). Click **OK** or press **Enter** on the keyboard to save changes.

![Patient Allergy Information](image)
6. The PIP Allergies Profile is retrieved for this patient.

**NOTE:** The bracketed numbers indicate the number of entries listed in the respective tabs. In the example shown below, the Allergies tab contains 9 entries.

![Image of Allergies tab](image)

**NOTE:** The colored data bars on the left side of each allergy entry provide information on whether local allergy records match PIP allergy records. Hover your mouse over the colored data bars to identify which entries need to be synchronized.

**Red (Local):** A red-local data bar indicates that the allergy entry exists on the local system only, but is not synchronized to a PIP allergy record.

<table>
<thead>
<tr>
<th>Drug Allergy</th>
<th>Status</th>
<th>Severity</th>
<th>Certainty</th>
<th>Refuted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macrolide Antibiotics</td>
<td>active</td>
<td>High</td>
<td>Unconfirmed</td>
<td>No</td>
</tr>
</tbody>
</table>

**Yellow (Network):** A yellow-network data bar indicates that the allergy entry exists on the Network (i.e. PIP) only, but is not synchronized with a local allergy record.

<table>
<thead>
<tr>
<th>Drug Allergy</th>
<th>Status</th>
<th>Severity</th>
<th>Certainty</th>
<th>Refuted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opioids/Morphine Related</td>
<td>active</td>
<td>High</td>
<td>Unconfirmed</td>
<td>No</td>
</tr>
</tbody>
</table>

**Green (Synced):** A green-synced data bar indicates that the allergy entry exists locally and is synchronized with a PIP allergy record. This is the desired outcome for all allergy entries because it indicates consistency between local and PIP records.

<table>
<thead>
<tr>
<th>Drug Allergy</th>
<th>Status</th>
<th>Severity</th>
<th>Certainty</th>
<th>Refuted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Penicillins</td>
<td>active</td>
<td>Moderate</td>
<td>Unconfirmed</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Gray (Network):** A gray-network data bar indicates that an allergy is completed/expired on the network and does NOT need to be synchronized to the local system.

<table>
<thead>
<tr>
<th>Drug Allergy</th>
<th>Status</th>
<th>Severity</th>
<th>Certainty</th>
<th>Refuted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lincosamides</td>
<td>completed</td>
<td>Low</td>
<td>Unconfirmed</td>
<td>Yes</td>
</tr>
</tbody>
</table>
7. Click **OK** at the bottom of the **Patient Network Profile** screen, or press **Enter** on the keyboard to continue. This will bring up the **CeRx Allergy Form**.

**NOTE:** The CeRx Allergy Form also contains the **Supporting Information** tab where additional information regarding **Reported Reactions** and **Allergy Tests** can be entered. Please see the section on **Supporting Information** for further details on how to add supplementary information for allergies.
8. Select an **Allergy** or **Intolerance Type** from the options available in the dropdown menu.

   d. **Allergy Selections:** Drug Allergy, Environmental Allergy, Food Allergy
   e. **Intolerance Selections:** Drug Non-Allergy Intolerance, Environmental Non-Allergy Intolerance, Food Non-Allergy Intolerance.

9. Identify the **Severity** of the indicated allergy as **High**, **Low**, or **Moderate**. A selection must be made in this field to successfully send the allergy/intolerance to PIP.

10. The **Certainty** of the allergy is always **Unconfirmed** at the pharmacy level because only doctors can mark an allergy as certain.
11. The **Effective Date** is the date the allergy was acknowledged by the patient. The date is defaulted to the current date, but can be manually changed.

![Effective Date field](#)

12. Optionally fill out the **Reported By** section of the CeRx Allergy From:

   a. **Date Reported** – The date that the pharmacy was made aware of the patient allergy.
   b. **Reported By** – Select from Patient, Relative, or Health Care Provider.
      i. When the allergy is reported by the **Patient**, no supplementary information is required for input.

   ![Reported By Patient](#)

      ii. When the allergy is reported by a **Relative**, the **Relationship**, **Last Name**, and **First Name** of the relative must be entered.

   ![Reported By Relative](#)

      iii. When the allergy is reported by a **Health Care Provider**, the **Provider type**, **Last Name**, **First Name**, and **Lic #** (License Number) can be entered.

**NOTE:** Click or press **F2-Select doctor** to search the local database for the applicable doctor.

![Reported By Health Care Provider](#)
13. Optionally enter a Comment regarding the nature and severity of the allergy (this comment will be saved and recorded on PIP).

**NOTE:** If a comment was entered in the local Patient Allergy Information form, it will be pulled into this field for recording on PIP. Users can manually delete the comment if they do not want it to be recorded on PIP.

14. Click OK at the bottom of the screen or press Enter on the keyboard to save changes to the CeRx Allergy Form, and to record the allergy or intolerance on PIP.

**Deleting a Patient Allergy/Intolerance**

Patient allergies can be deleted locally on Kroll, and then the user can decide whether they want to mark the allergy/intolerance as expired on the Network as well. Delete an allergy/intolerance as follows:

1. Search and call up the F3 Patient card.

2. From the Allergies section of the patient card, highlight the allergy/intolerance you want to remove and click Del or press Delete on the keyboard.

3. Answer Yes to the question “Are you sure you want to delete this allergy/intolerance?”

4. A window will open asking “This allergy is linked to a network record. How would you like to proceed?” There are three options to choose from:
Saskatchewan Pharmacy Network

a. **Complete/expire the network allergy/intolerance**: A message will be sent to PIP to mark the Intolerance as completed on the Network.
b. **Retract the network allergy/intolerance**: Removes the allergy or intolerance from the PIP.
c. **Abort**: Cancels out of the deletion process.

![Select an Option](image)

**NOTE**: Pharmacy users can only mark Intolerances as completed/expired on the network, but not Allergies. Only doctors can mark an allergy as completed/expired. If a pharmacy user attempts to mark an ALLERGY as completed/expired on the network, they will receive the following prompt:

![Message](image)

The allergy is deleted locally. The user still needs to go to the **Patient Network Profile** to Retract the ALLERGY or add a note if there is an issue with the allergy.
Deleting a Patient Allergy/Intolerance that has a note recorded on the network

There may be times when a note has been recorded on the network for a patient allergy. In order to retract an allergy from the local system, the allergy note will need to be retracted first. You won’t know the note needs to be retracted first until you attempt to delete the allergy locally.

1. Locate the Allergy to be deleted/retracted and click **Del** or press the **Delete** key on your keyboard.

2. Answer **Yes** to the ‘**Are you sure?**’ prompt.

3. Select **Retract the network allergy/intolerance**.
4. The retract will fail with the following issue and it cannot be deleted. Because a note has been added to the allergy on the network, the record has been modified. Therefore you cannot delete the Allergy off the Network or locally. Click **Cancel**.

![Network Detected Issue Detail](image1)

![Network Detected Issues](image2)

5. Select **Network > Profile** and log in.

![Profile](image3)
6. Click **OK**.

![Select the Profiles to query](image1)

7. Go to the **Allergy** tab and highlight the allergy you wish to retract the note from.

![Allergy tab](image2)

8. Right-click and select **Retract**.

![Retract option](image3)
9. A list of items available for retraction is displayed. Select the **Allergy Note** transaction type and click **OK**.

![Image of select action to retract from the following list]

10. Answer **Yes** to the ‘Are you sure?’ prompt.

![Image of Are you sure?]

11. Now that the Allergy note is removed, exit the *(Network)* **Patient Profile**.

12. Locate the Allergy to be deleted/retracted and click **Del** or press the **Delete** key on your keyboard.
13. Answer **Yes** to the ‘**Are you sure?**’ prompt.

14. Select **Retract the network/allergy/intolerance**.

15. Allergy is successfully removed locally and on the network.
Saskatchewan Pharmacy Network

Synchronizing Network Allergies to the Local Kroll System

As noted earlier, a yellow **Network** data bar indicates that an allergy entry exists on PIP, but is not synchronized to a local Kroll allergy. A red **Local** data bar indicates that an allergy entry exists on Kroll, but is not synchronized to a PIP allergy entry. It is important to keep the local and PIP allergies in sync so that pharmacists everywhere can make the most accurate dispensing decisions. Synchronize allergy entries as follows:

1. From the Patient Card, go to **Network > Profile** and log in with your user initials and password.

2. From the **Select the Profiles to query** form, click **OK** or press **Enter** on the keyboard.

3. Enter an **OPTIONAL** reason for accessing the patient profile and click **OK** or press **Enter** on the keyboard to continue.
4. From the **Allergies** tab of the **Patient Network Profile**, highlight the allergy entry that requires synchronization.

5. Click **Extra Functions**, press **X** on the keyboard, or right click on the allergy entry and select **Synchronize**...
a. If you are synchronizing a yellow-network allergy entry, the Select the local allergy to link to form will appear. Highlight a matching local allergy if available and then click Select. If a matching local allergy does not exist, click Add to Local or press Ctrl A.

b. If you are synchronizing a red-local allergy entry, the Select the network allergy to link to form will appear. Highlight a matching network allergy if available and click Select. If a matching network allergy does not exist, click Add to Network or press Ctrl A, fill out the CeRx Allergy Form and click OK or press Enter to save information.

6. When the Network allergy record is synchronized with the Local allergy record, the data bar will refresh to a green ‘Synced’.
Adding an Intolerance to an Existing Allergy Group

An allergy is a reaction produced when the body meets a substance that elicits an immune response. Intolerance happens when unpleasant symptoms occur after ingesting a substance that the body cannot break down. In other words, an allergy affects the body’s immune system while intolerance generally affects the body’s metabolism.

It is possible to add Intolerance AND an allergy for the same allergy group; for example, an allergy and intolerance can be added for Penicillin. The following illustrates how to do this.

1. From the patient card, go to **Network > Profile** and log in with your user initials and password.

2. From the **Select Profiles to query** form, check whether or not a patient’s medication profile is returned with the allergies profile and click **OK** or press **Enter** on the keyboard to continue.

3. Enter an OPTIONAL reason from the Comments dropdown menu for accessing the patient profile and click **OK** or press **Enter** on the keyboard to continue.

![Select the Profiles to query](image)

**NOTE:** It is recommended that users enter a reason for accessing the Network Profile for potential auditing purposes down the road.
4. From the **Allergies** tab of the **Patient Network Profile**, highlight the allergy you want to also add as intolerance (the example below uses Penicillin). **Right click** or select **Extra Functions** to **Unsynchronize**.

![Unsynchronize](image)

5. Subsequent to **Unsynchronizing**, the result will be a **Red-Local** entry and a **Yellow-Network** entry for the allergy group.

6. Highlight the **Red-Local** allergy entry and **right click** or select **Extra Functions** to **Synchronize**.

![Synchronize](image)

7. From the Select the network allergy to link to screen, click **Add to Network**.

**NOTE**: Do not select/highlight any entries in the list before clicking **Add to Network**.
8. Fill out the CeRx Allergy Form for the Drug Non-Allergy Intolerance and click OK or press Enter to send information to PIP.

9. Once the Drug Non-Allergy Intolerance has been successfully added to PIP, the following message will appear:

10. Click OK or press Enter on the keyboard to return to the Patient Network Profile.
11. Highlight the **Yellow-Network** drug allergy entry and right click or select **Extra Functions** to **Synchronize**.

12. From the **Select the local allergy to link to** screen, highlight the local allergy you want to link the Network allergy to and click **Select**.

13. The resulting **Allergies Network Profile** will have an **ALLERGY** and an **INTOLERANCE** synced to the Network for the same allergy group.
Supporting Information

Supporting Information for patient allergies and/or intolerances can be recorded on PIP from the Kroll system. Supporting Information gives users the option to provide details on Reported Reactions and Allergy Tests. The Supporting Information tab located on the CeRx Allergy Form is available when new allergies are added to the system. The Supporting Information tab can also be accessed subsequent to adding a new allergy as follows:

1. Bring up the Patient card using the F3 Patient search.
2. Go to Network > Profile and log in with your user initials and password.
3. From the Select Profiles to query form, check whether or not a patient’s medication profile is returned with the allergies profile.

4. Click OK or press Enter on the keyboard from the Select Profiles to query form.
5. Enter an OPTIONAL reason from the Comments dropdown menu for accessing the patient profile and click OK or press Enter on the keyboard to continue.
6. From the **Allergies Tab**, highlight the entry requiring **Supporting Information** and click **Extra Functions**, press X on the keyboard, or right click to select **Update Allergy**.

![Image 1](image1.png)

7. From the **CeRx Allergy Form**, click on the **Supporting Information** tab or press CTRL+S on the keyboard.

![Image 2](image2.png)
Reported Reactions

Supplementary information regarding patient reactions to allergies and/or intolerances can be entered in the **Reported Reaction** section as follows:

1. Click **Ins** or press **Insert** on the keyboard from the **Reported Reactions** section of the **Supporting Information** tab which will bring up the **Allergy-Reported Reaction** form.

- **Reaction**: Click or press **F2** to search for the allergic reaction experienced by the patient. (e.g. Search “rash”, “diarrhea”, etc.).
- **Severity**: Identify the **Severity** of the indicated allergy as **High**, **Low**, or **Moderate**.
- **Reaction Occurred**: This flag is checked by default and indicates the stated reaction has been physically suffered by the patient.
• **Onset Date:** Optionally enter the date the patient first started experiencing the allergic reaction.
• **Description:** Optionally enter a description of the allergic reaction.

![Image of observation form]

**NOTE:** Press CTRL+ENTER to start a new line in this field.

• **Drug:** If the allergic reaction was drug induced, click or press F2 to search for the drug.

![Image of drug selection]

• **Other:** If the allergic reaction was induced by a substance other than a drug, attempt to locate the substance from the options available in the dropdown menu.

![Image of other selection]
• **Method:** Indicate the method with which the allergen entered the patient’s body. Select from one of the available options in the dropdown menu.

2. Once all pertinent information regarding the allergic reaction has been entered, click **OK** or press **Enter** on the keyboard to save the **Reported Reaction**.

3. Click **OK** or press **Enter** on the keyboard from the **CeRx Allergy Form** to send reaction information to PIP.

4. Once the **Reported Reaction** has been successfully saved on PIP, the following message will appear.

5. Click **OK** or press **Enter** on the keyboard to continue.
Allergy Tests

Supplementary information regarding patient allergy testing can be entered in the Allergy Tests section as follows:

1. Click Ins or press Insert on the keyboard from the Allergy Tests section of the Supporting Information tab which will bring up the Allergy-Tests form.

2. **Record Id**: Optionally enter the “record number” for the allergy test.

3. **Date**: Enter the date that the allergy test results were received.
4. **Type:** Click or press **F2** to search and select the type of allergy test performed on the patient.

**NOTE:** Searching with an asterisk “*” will bring up ALL the available allergy tests.

5. Select the severity of the allergy test results from the **Result** menu.

6. Once all pertinent information regarding the allergy test has been entered, click **OK** or press **Enter** on the keyboard to save **Allergy Tests**.

7. Click **OK** or press **Enter** on the keyboard from the **CeRx Allergy Form** to send the allergy test information to PIP. Once **Allergy Tests** has been successfully saved on PIP, the following message will appear.

8. Click **OK** or press **Enter** on the keyboard to continue.
Retrieving Allergy Information from PIP

1. Bring up the Patient card using the F3 Patient search.

2. Go to Network > Profile and log in with Kroll initials and password.

3. From the Select Profiles to query form; check whether a patient’s medication Profile is returned with the allergies profile.

4. Click OK or press Enter on the keyboard from the Select Profiles to query form.

5. Optionally enter a reason for accessing the PIP profile and click OK or press Enter on the keyboard to continue.

6. Access the Allergies tab from the Patient Network Profile to view allergies and intolerances.
7. Allergy results coming back from PIP can be filtered according to **Status** and **Allergy Type**.

8. Checking the **Advanced** flag allows you to filter allergy results further by **Severity** of the allergy, **Certainty** of the allergy, whether the allergy is added **locally**, or if the allergy is **Refuted** (i.e. completed/expired).

9. Allergy results can be listed in order by **Allergy/Intolerance**, **Allergy Type**, **Severity** or **Effective date** by clicking on the corresponding buttons. (The default sort order is **Effective date**).
Viewing Allergy Details from PIP

1. Bring up the Patient card using the F3 Patient search.

2. Go to Network > Profile and log in with user initials and password.

3. From the Select Profiles to query form; check whether a patient’s medication Profile is returned with the allergies profile.

4. Click OK or press Enter on the keyboard from the Select Profiles to query form.

5. Enter an OPTIONAL reason for accessing the network profile and click OK or press Enter on the keyboard to continue.

6. From the Allergies Network Profile highlight the allergy of interest and call up the Allergy Detail screen in one of four ways:
   a. Click the Detail button located on the bottom of the screen.
   b. Press D on the keyboard.
   c. Click on Extra Functions and select Detail.
   d. Right click on the allergy entry and select Detail.
   e. Double-click the allergy
Four tabs are available from the Allergy Detail screen:

- Allergy/Intolerance
- Recorded By/At
- Supporting Information
- Notes

Click on the tabs to bring information forward. Note that information listed in the Allergy/Intolerance tab and Recorded By/At tab are returned by PIP; Kroll does govern the accuracy of the data in these fields.

**Extra Functions from the Allergies Profile**

Extra Functions are available from the Allergies tab of the Network Profile and can be accessed as follows:

1. Bring up the Patient card using the F3 Patient search.
2. Go to Network > Profile and log in with your user initials and password.
3. From the Select Profiles to query form; check whether a patient’s medication Profile is returned with the allergies profile.

4. Click OK or press Enter on the keyboard from the Select Profiles to query form.
5. Enter an optional reason for accessing the network profile and click OK or press Enter on the keyboard to continue.
6. From the **Allergies** tab, access **Extra Functions** in one of three ways:

   a. Highlight the Rx and click the **Extra Functions** button.
   b. Highlight the Rx and press **X** on the keyboard.
   c. Highlight the Rx and **Right Click** on the mouse.
Saskatchewan Pharmacy Network

Synchronize

See the Synchronizing Network Allergies to the Local Kroll System section for information on synchronizing allergies and intolerances.

Unsynchronize

Unsynchronizing will break the link between the local allergy record and the Network allergy record. Only Green-Synced Network records have the option to Unsynchronize. When a Green-Synced Network record is unsynchronized, the resulting allergy profile will have a Yellow-Network allergy entry and a Red-Local allergy entry.

Before Unsynchronization:
After Unsynchronization:

**NOTE:** After unsynchronizing, there will be a Yellow-Network allergy record and a Red-Local allergy record, but they will not be linked to one another.

**Retracting an Allergy**

Allergies, intolerances, supporting information, and other allergy related transactions sent to PIP can be retracted (i.e. withdrawn) on two conditions:

1. The transaction is being reversed from the same pharmacy it was sent from.
2. The patient Network profile has not been viewed by another user/pharmacy.

If these conditions are violated, executing a retract function on an allergy transaction will elicit a rejection message.
To retract an allergy transaction from PIP via Kroll:

1. From the **Allergies** tab, highlight the allergy record that needs to be retracted.

   ![Allergies Tab]

2. Access the **Extra Functions** menu and select **Retract**. This will call up a list of allergy transactions to retract.

3. Highlight the transaction that needs to be retracted and click **OK** or press **Enter** on the keyboard.

   ![Retract Transaction]

**NOTE:** If an allergy note was added after the Allergy, the note has to be retracted first.
4. Answer **Yes** when asked “Are you sure you want to retract this Allergy action?”

![Image of a dialog box asking if the user is sure they want to retract an allergy action]

5. When the user answers **Yes** to the above question, the allergy retract will complete (if retractable).

**WARNING:** Retracting an allergy/intolerance entry on PIP will **NOT** delete the allergy/intolerance locally from Kroll. Highlight the retracted allergy/intolerance from the **Allergies** section of the Kroll patient card and click **Del** or press **Delete** on the keyboard to remove locally.

**Add Allergy/Intolerance Note**

Additional notes can be added to allergy records at any time. Adding a note to a Network allergy record is as follows:

1. From the **Allergies** tab, highlight the allergy that you want to add a **Note** for.
2. Access the **Extra Functions** menu and select **Add Note**.
3. This will call up the Add Note to Record form. Enter the note in the Note field. Press Ctrl + Enter to start a new line.

4. Click OK or press Enter on the keyboard to save changes to the Add Note to Record form.

5. A blue indicator displays on the summary screen to indicate that there are note(s) on the allergy.

**NOTE:** Pharmacy User should always detail the allergy as there maybe more than one note recorded. This is done by detailing the allergy/intolerance (i.e. highlight the entry and click Detail or press D on the keyboard), then click on the Notes tab. The bracketed number on the tab indicates the number of notes listed for the allergy/intolerance.
Get Allergy/Intolerance History

The Get History option allows users to track incremental changes made to an allergy record. (For e.g., to ascertain when a Supplementary Information or a note was added, etc.).

1. From the Allergies tab, highlight the allergy entry you want to Get History for.

2. Access the Extra Functions menu and select Get History. This will call up the Allergy History screen.
3. The **Allergy History** screen will list an entry for every instance where a change in the allergy record has been made.

**NOTE:** The date listed on the upper left hand corner of the entry denotes the date that the allergy record was changed. Changes made to allergy records are only logged by the PIP; therefore, allergy history entries are tagged with a **Yellow-Network** data bar.
4. View the details of one allergy history entry versus another to track the changes that were made. See the details of an Allergy History Entry by highlighting the entry and clicking Details or pressing D on the keyboard; this will call up the Allergy Detail screen.
Network Options from the Patient Card

Network options can be accessed from the F3 patient card under the Network dropdown menu.

Profile

1. From the patient card go to Network > Profile or press Ctrl + F3.
2. Log in with your user initials and password.
3. Override the reason for accessing the profile (optional).
4. Enter an additional comment or choose one from the available list (optional).
5. From the Select the Profiles to query form, check the Profile flag to retrieve the patient medication profile. Enter the number of months of data being retrieved from PIP.
6. Once profile selections have been made, press Enter on the keyboard or click OK to continue.
7. Click on the tabs located on the top of the Patient Network Profile to access the corresponding information.

   a. Profile: The profile shows all prescriptions filled for a patient.
   b. Allergies: Lists all the allergies and intolerances for the patient.

**NOTE:** The bracketed numbers indicate the number of entries listed in the respective tabs. In the example shown below, the medication Profile tab contains 64 entries, and the Allergies tab contains 6 entries.
8. An **Advanced** search can be performed to refine results coming back from PIP. Narrow search parameters by checking the **Advanced** flag and entering additional search criteria. Click **Filter** or press **Enter** on the keyboard to obtain more specific Network results.

9. View prescription details on the **Patient Network Profile** in one of three ways:
   
   a. Highlight the prescription and click the **Detail** button.
   b. Highlight the prescription and press **D** on the keyboard.
   c. Right click on the prescription and click **Detail**.
   d. **Double-click** to get the Details.

![Medication Order Detail Screen](image)

10. The **Medication Order Detail** screen will open with the details of the prescription. Click on the tabs located on the top of the screen to access corresponding information.

11. Click **OK** or press **Enter** on the keyboard to exit from the **Medication Order Detail** screen and return to the **Patient Network Profile**.
12. An **Advanced** search can be performed to refine search results coming back from PIP. Narrow search parameters by checking the **Advanced** flag and entering additional search criteria. Click **Filter** or press **Enter** on the keyboard to obtain more specific Network results.
Not Dispensed Profile

The **Not Dispensed** profile filters prescriptions coming back from PIP to entries that are considered other medications or over-the-counter (OTC) such as Gravol, baby aspirin, vitamins, etc.

**NOTE:** In order for a prescription to be logged on PIP as **not dispensed**, it must be sent as a **not dispensed Rx** from Kroll.

1. From the patient card, go to **Network > Not Dispensed Profile**.
2. Log in with Kroll initials and password.
3. Enter an optional reason for accessing the patient’s Network profile.
4. A list of **Not Dispensed** prescriptions will be returned by PIP.

5. View details for **Not Dispensed** entries on the Network profile in one of three ways:
   a. Highlight the prescription and click the **Detail** button.
   b. Highlight the prescription and press **D** on the keyboard.
   c. Right click on the prescription and click **Detail**.
d. **Double-click** to bring up the details.

6. The **Medication Order Detail** screen will open with the details of the **Not Dispensed** prescription. Click on the tabs located on the top of the screen to access corresponding information.

7. Click **OK** or press **Enter** on the keyboard to exit from the **Medication Order Detail** screen and return to the **Patient Network Profile**.
Add Consent

Saskatchewan patients have the ability to mask their Patient Network Profile so that only certain medical professionals have the right to view their medical history.

A patient with a masked medication profile will elicit the following message from PIP when a Network request is sent:

Healthcare providers can gain access to a patient’s full network profile if the patient provides consent. Log consent in Kroll as follows:

1. From the F3-Patient card, select Network > Add Consent.
2. Log in with user initials and password to bring up the Record Consent form.

- Enter the period of consent provided by the patient. The Start Date and End Date are defaulted to the current date, but can be manually changed.
- **Revoke consent:** Check this flag if the patient requests that their medication and allergy profile no longer be available for viewing by pharmacy staff. Consent can be revoked at any time.
- **Consent Provided By:** Indicate who provided consent to view the patient profile.
  a. **Patient:** Check this flag if the patient provided consent.
  b. **Representative:** Check this flag if a legal guardian, power of attorney, etc. provided consent on behalf of the patient.

- Press F2 to enter information on the representative field.
- From the Select Responsible Party form, click F2 to select an existing patient from the Kroll database, or simply enter information manually into the available fields.
NOTE: When a **Representative** is providing consent, the **First Name** and **Last Name** of the representative must be sent to PIP or the following warning will appear.

- **Provider**: Check this flag if the patient’s doctor or pharmacist deems it necessary to view the patient’s network profile without patient consent. This is also known as “**breaking the glass**”.

- If the **Patient** or a **Representative** provides consent, select the **Method** that consent was granted:
a. Physical presence  
b. Verbal consent

- If a Provider (i.e. doctor, pharmacist) overrides consent, select a Reason for the override from one of two options:
  a. Emergency  
  b. Professional Judgment

**NOTE:** A Reason MUST be specified when a provider (i.e. doctor) overrides consent.
3. Click OK or press Enter on the keyboard to save changes to the Record Consent form.

4. Go to Network > Profile and login with User initials and password as usual to call up the Patient Network Profile. The full medication profile along with patient allergies will now be listed.
NOTE: When filling an Rx for a patient that consent has not been added, it will return The person information is not viewable. Press OK, go back to the patient and add consent. Before going back to fill the Rx, view the Network Profile manually and then proceed to filling the Rx.

View Network Access Log

The Saskatchewan Ministry of Health is at liberty to request information regarding why a patient’s medication and/or allergy profile was accessed from PIP. Consequently, Kroll always prompts the user to enter a reason for accessing a patient’s network profile. Details on whom, when and why the patient’s profile has been accessed can be retrieved as follows:

1. From the F3-Patient card go to Network > View Network Access Log.

2. Log in with Kroll initials and password to bring up the Network Access Log for the patient.

3. Click Print or press CTRL+P to print the Network Access Log.
4. Click **OK** or **Cancel** to exit from the Network Access Log and return to the F3 Patient card.

![Network Access Log](image)

**PIP Portal**

The network option for **PIP Portal** allows users to access the traditional PIP viewer via web browser.

1. The **Network > PIP Portal** can be accessed from the **F3-Patient** card, **ALT-X-Start** screen or the **F12** screen.

**Patient Card:**

![Patient Card](image)

**Alt-X – Start Screen:**

![Alt-X – Start Screen](image)
2. The PIP viewer website will be automatically brought up (https://pip.ehealthsask.ca/).

3. Login with PIP GUI username and password.

**View Claim Log**

The **Network Claim Log** provides detailed information regarding the requests sent to PIP and the corresponding responses coming back from PIP (e.g. profile requests, consent records, allergy records, etc.). Entries contained in the Network Claim Log are not organized in a patient specific manner; it simply lists ALL transactions ‘sent to’ or ‘received from’ PIP in chronological order for a configurable number of days. Access the claim log as follows:

1. From the F3-Patient screen or Alt-X - Start screen, select **Network > View Claim Log**.

**Patient Card:**

2. Log in with Kroll initials and password to bring up the Select a Log Entry screen.
3. Enter the number of days of data being retrieved in the **Days** field.

![Days field](image)

4. Highlight the log entry of interest and click Select or press Enter on the keyboard to pull up the CeRx Log Viewer. The left side of the screen shows Claim Data sent to PIP, and the right side of the screen shows Response records coming back from PIP.

![Log Viewer](image)

5. Click **Previous** to see the log file for the preceding transaction; click **Next** to see the log file
for the following transaction; and click OK to exit from the CeRx Log Viewer.

<table>
<thead>
<tr>
<th>Patient Name</th>
<th>Date Sent</th>
<th>Transaction Type</th>
<th>Origin User</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kroll, Karen</td>
<td>29/07/2013 11:13:17</td>
<td>General Query</td>
<td>KC</td>
<td>KC</td>
</tr>
</tbody>
</table>

**Patient Network Profile**

**(Network) Patient Profile Details**

Patient information on the Patient Profile may reside locally on the Kroll database, and/or on the Saskatchewan PIP database. Many of the patient’s records may be the same on both databases, and some data may exist on only one or the other. Kroll uses indicators to alert the user to the source of the data being returned in the Patient’s Network Profile.

- Indicates that this order exists on the local profile only. This order is displayed for information only, in order to give the user a more complete picture of this patient’s profile. No Extra or Detail functions may be performed against this order.

- Indicates that this order is both on the local & Network DIS Profile.

- Indicates that this order is from the Network, and does not exist on the local profile.
<table>
<thead>
<tr>
<th>Status</th>
<th>Drug Description</th>
<th>Code</th>
<th>Manufacturer</th>
<th>Refill</th>
<th>Date</th>
<th>Order Type</th>
<th>Status</th>
<th>Physician</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unfilled</td>
<td>30 TAB PERCOCET 5-325 MG TABLET</td>
<td>01916475</td>
<td>PM</td>
<td>Yes</td>
<td>14-Apr-2016</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 TABLET ONCE DAILY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Active</td>
<td>Kroll</td>
</tr>
<tr>
<td>14-Apr-2016</td>
<td>30 CAP ALTACE 1.25 MG CAPSULE</td>
<td>02221029</td>
<td>VALEANT</td>
<td>Yes</td>
<td>14-Apr-2016</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 CAPSULE ONCE A DAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Active</td>
<td>Kroll</td>
</tr>
<tr>
<td>14-Apr-2016</td>
<td>30 CAP APO-MINOXYCLINE 50 MG CAP</td>
<td>02084880</td>
<td>APOTEX</td>
<td>Yes</td>
<td>14-Apr-2016</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 CAPSULE ONCE A DAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Active</td>
<td>Kroll</td>
</tr>
<tr>
<td>14-Apr-2016</td>
<td>20 TAB TORADOL 10 MG TABLET</td>
<td>02162668</td>
<td>ATRAMOS</td>
<td>Unassigned</td>
<td>14-Apr-2017</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TOPADOL 10 MG TABLET; Take from 14-Apr-2016 to 24-Apr-2016; Cure, Dosage Line: #1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 CAPSULE 3 TIMES A DAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Active</td>
<td>Kroll</td>
</tr>
<tr>
<td>17-Mar-2016, 17-Mar-2016</td>
<td>7 TAB PMS-MALEOXICAM 7.5 MG TABLET</td>
<td>02240267</td>
<td>PHARMASCIEF</td>
<td>No</td>
<td>03-Mar-2016</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 TABLET ONCE DAILY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Revoked</td>
<td>Kroll</td>
</tr>
<tr>
<td>17-Mar-2016, 17-Mar-2016</td>
<td>7 TAB APO-FUROSEMIDE 80 MG TABLET</td>
<td>00707570</td>
<td>APOTEX</td>
<td>No</td>
<td>18-Mar-2016</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 TABLET ONCE DAILY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Active</td>
<td>Kroll</td>
</tr>
<tr>
<td>17-Mar-2016, 17-Mar-2016</td>
<td>7 TAB APO-FUROSEMIDE 80 MG TABLET</td>
<td>00707570</td>
<td>APOTEX</td>
<td>No</td>
<td>18-Mar-2016</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TAKE 1 TABLET ONCE DAILY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Revoked</td>
<td>Kroll</td>
</tr>
</tbody>
</table>
Network Rx entries on the (Network) Patient Profile have indicator icons and colored bars located on either end to quickly give the user extra information about an order:

Left Hand Side Indicators:

- The 😞 icon indicates that this order has a Refusal to Fill recorded against it.
- The ▼ icon indicates that this order has Detected Issue(s) recorded against it.
- The □ icon indicates that this order has Note(s) recorded against it.
### Right Hand Side indicators:

- The ✔ icon indicates that this Order is **Fillable**.
- The ❌ icon indicates that this Order is **no longer Fillable**.
- The Rem Qty is indicated with a whole number and the number of refills based on the quantity is in brackets.

<table>
<thead>
<tr>
<th>Last Filled</th>
<th>Picked Up</th>
<th>Status</th>
<th>Doctor</th>
<th>Code</th>
<th>Manufacturer</th>
<th>Local</th>
<th>PIP Order</th>
<th>Order Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Revoked</td>
<td>Physician, Kroll</td>
<td>02248287</td>
<td>PHARMACIEI</td>
<td>No</td>
<td>00003027</td>
<td>03-Mar-2016</td>
</tr>
</tbody>
</table>

- The colored bars indicate the source of the Order:
  - **Yes** Indicates that this Order is assigned to this location
  - **No** Indicates that this Order is assigned to another Location
  - **Unassigned** Indicates that this Order has not been Assigned to a particular location

### Accessing Extra Functions

Extra Functions are available from the Patient Network Profile (i.e. PIP Profile) and can be accessed as follows:

1. From the **F3-Patient** card, go to **Network > Profile**.
2. Login with Kroll initials and password.
3. From the **Select the Profiles to query** form, check **Profile**. Enter the number of months of data being recovered from PIP.

![Select the Profiles to query form]

4. Once profile selections have been made, press **Enter** on the keyboard or click **OK** to continue.

5. Enter an OPTIONAL reason for accessing the **Patient Network Profile**.
6. From the Allergies tab, access Extra Functions in one of three ways:

   a. Highlight the Rx and click the Extra Functions button
   b. Highlight the Rx and press X on the keyboard
   c. Highlight the Rx and Right Click on the mouse.
Create Local Rx with DIN

The option to Create Local Rx allows users to pull prescription information (i.e. patient, drug, doctor, and dispensing information) from the Network Profile into the local Kroll F12-Filling screen. This function allows pharmacy users to select a prescription record from PIP and pull it into the local system for filling. The Create Local Rx function can only be used for network prescription entries that do not exist locally.

If the user attempts to execute the Create Local Rx function on a network prescription entry that exists locally, the following message will appear: “This order is not fillable; This Rx Order already exists in your database.”
Create a Local Rx as follows:

1. Highlight/Check the network prescription(s) entries that you want to fill locally and access Extra Functions to select Create Local Rx.
2. The Create Local Rx – Network Rx Order screen will appear so that you can view what information is being pulled into the local F12 Filling screen.

**NOTE:** Information on this screen cannot be changed or modified.

![Create Local Rx - Network Rx Order](image)

3. This screen is movable and can be moved to the side to verify the information. You can either close it manually or when the Rx is finished, it will close automatically.

**NOTE:** The sig directions may need to be cleaned up to make it readable for the patient.
4. Click **Lookup** or press **Enter** on the keyboard to select the applicable drug and doctor information from the local database. If the local database does not have the drug or doctor you are looking for, the corresponding records need to be added.

5. Make any necessary changes to the prescription before clicking **F12-Fill Rx** or pressing **F12** on the keyboard to fill the Rx.

**NOTE:** If the user would like to recall the **Create Local Rx – Network Rx Order** screen to view details of the Network prescription, go to **Network > View ‘Create Local Rx’ Information.**

A low priority warning will be returned, this is because structured dosage is not implemented in Kroll therefore it is not included in the dispense that is sent to the Network. This warning does not need to be managed.

**NOTE:** You can **NOT** add repeats or change the authorized quantity to a prescription that has been pulled from the Network using the **Create Local Rx** function.
Create Local Rx from another Pharmacy

1. Highlight or place a check mark next to the network prescription(s), right click or access Extra Functions and select Create Local Rx.

2. This will open the PIP “Create Local Rx” Validation screen. Click Continue.
3. This will open **Transfer Rx from other** store screen. Fill in transfer information.

**NOTE:** If this Transfer Screen does not open automatically, you will need to manually open this form from the Rx filling screen on the right tool bar and select **Transfer Rx from Another Store**.
4. Clicking on OK will send the Transfer from message to the Network.

5. Fill in the Rx filling screen and hit F12 to fill the Rx.

6. On the Network, the Prescription Order belongs to your pharmacy.
Create Local Rx with GCN Sequence Number

An Rx can also be created if there is no DIN but a GCN sequence number.

1. Highlight or place a check mark next to the network prescription(s), right click or access Extra Functions and select Create Local Rx.
2. The GCN number will automatically be entered into Drug Search. Pick the brand you wish to dispense.

![Drug Search Image]

This takes you back to the Fill screen. All of the Network information is inputted on the Rx screen.

![Fill Screen Image]

3. Click F12-Fill Rx or press F12 on the keyboard to dispense the prescription.
Refusal to Fill

This message is used when a pharmacist decides they ‘will not’ or ‘cannot’ fill a prescription for a patient. The intent of the message is to record situations such as suspected abuse, poly-pharmacy activities, and operational situations such as ‘out of stock’ item, but can be used as the pharmacist deems fit. A pre-populated dropdown menu of Refusal Reasons is available for selection and submission to PIP.

1. To claim a Refusal to Fill, Unfill the Rx to send the Rx Order to PIP.
2. A warning message appears, click **OK** to continue.

![Image of a warning message](image1)

3. Go to the **Network Patient Profile** and locate the Rx you wish to **Refusal to Fill**. Right click and select **Refusal to Fill**.

![Image of a patient profile](image2)
4. Select a **Refusal Reason**.

![Refusal Reason](image)

**NOTE**: On the **Network Profile Summary** screen, there is a red circle icon with a white line to indicate that this is a refusal to fill Rx.

![Network Profile Summary](image)

5. When you detail the Rx, it will show under the **Refusals** tab.

![Refusals](image)

**NOTE**: If a refusal to fill fee needs to be claimed to ADAPT, this is done in a separate Rx with the Refusal to Fill fee drug card. This is not sent to PIP.
Hold (Suspend) Rx

A prescription is put on hold when a provider determines that a drug should not be taken by the patient for a specified interval of time. This identifies the intent that the drug therapy be continued in the future, but that it is suspended for the period indicated on the hold. A prescription that is on hold will have a status of Suspended on the Patient Network Profile.

There are two scenarios for placing an Rx on Hold:

a. Network Rx not assigned to the Local pharmacy
b. Network Rx assigned to Local pharmacy
Hold (Suspend) Network Rx not assigned to the Local Pharmacy

1. Highlight the Rx from the Patient Network Profile and select Hold (Suspend) Rx from the Extra Functions menu.

2. This will call up the Hold Network Rx form.

   a. In the Effective Date field, enter the date that the hold begins (i.e. when the patient should stop taking the medication).
   b. In the End Date field, optionally enter the date that the hold ends (leaving this field blank means that the hold is indefinite).
c. From the **Reason Code** field, access the dropdown menu and select an option to explain why the prescription was placed on hold.

3. Click **OK** or press **Enter** on the keyboard to execute the hold.

**NOTE:** The **Reason Code** field cannot be populated free-form. A selection must be made from one of the reasons provided.

### Hold (Suspend) Network Rx Assigned to the Local Pharmacy

An Rx that was created or dispensed locally has to be put on **HOLD** locally. If an attempt is made to **HOLD** a local Rx on the Network, an error message will be displayed.

1. Highlight the Rx..
2. Select Extra Function > Suspend.
3. The **Suspend Rx(s)** form opens. Select a mandatory reason and enter a comment optionally.
4. Click **Suspend Eligible Rxs**.

5. Locally the Rx has a status of **Suspended**.
6. On the Network the Rx has a status of **Suspended**.

![Patient Profile Screen]

**Release (Resume) Rx**

The option to **Release (Resume) Rx** is used to release prescriptions that are currently on hold (i.e. status **Suspended**). For example, a patient who transitions from an inpatient situation back to the community may require held prescriptions to be “released”.

There are two scenarios for **Releasing** an Rx:

- a. Suspended Network Rx not assigned to the Local pharmacy
- b. Suspended Network Rx assigned to Local pharmacy
Release (Resume) Suspended Network Rx

1. To release a prescription that is on hold, highlight the suspended Rx from the Patient Network Profile and select Release (Resume) Rx from Extra Functions menu.

2. This will call up the Release Network Rx form.

   a. In the Effective Date field, enter the date that the prescription was taken off hold (i.e. suspend) status.
   
   b. From the Reason Code field, access the dropdown menu and select an available option to explain why the prescription was taken off hold.

3. Click OK or press Enter on the keyboard to execute the Release Rx.

**NOTE:** The Reason Code field cannot be populated free-form. A selection must be made from one of the reasons provided.
Release (Resume) Suspended Local Rx

A local Rx that has been suspended can only be Resumed/ Released from the local patient profile.

1. Go to patient profile, highlight Rx and then go to Extra Functions and select Resume.
2. The Resume Rx(s) window will open. Select a reason for resuming the Rx and then click on Resume Eligible Rx(s) to send the message to the Network.

3. The local Rx and associated Network Rx are now available for filling.
Revoke Dispensing Permission

The option to **Revoke Dispensing Permission** is used when a **doctor** has decided that the prescription should no longer be dispensed to the patient. The intent of the message is to inform the dispenser (e.g. Pharmacist) that the patient should continue to consume the medication that they have in their possession until it is gone, but no further dispenses are allowed against the prescription (i.e. all remaining refills are cancelled).

Revoke Dispensing Permission on the Network

1. To **Revoke** a prescription, highlight the Rx from the **Patient Network Profile** and select **Revoke Dispensing Permission** from the **Extra Functions** menu.

2. This will call up the Revoke Network dispensing permission form.

   a. In the **Effective Date** field, enter the date that the prescription was revoked (i.e. future refills stopped).

   b. From the **Reason Code** field, access the dropdown menu and select an option to explain why the prescription is being revoked.
3. Click **OK** or press **Enter** on the keyboard to execute the revocation.

**NOTE:** The **Reason Code** field cannot be populated free-form. A selection must be made from one of the reasons provided. If you attempt to fill a prescription that has been revoked on the Network, PIP will accept the prescription, but will return the following warning:

![Image of warning message]

**Details:** The prescription being dispensed has had dispensing permission rights revoked.

Revoke Dispensing Permission locally

1. Locate Rx in patient profile. Highlight it and press **I** on the keyboard to **Inactivate**.

2. The **Inactivate Rx(s)** form will open.

3. Click **Revoke**.

4. Select a **Reason Code**.
5. Rx has a status of **Inact** locally.

6. On the Network, the Rx has a status of **Revoked**.
Stop (Abort) Rx

The option to Stop (Abort) Rx is used when a pharmacist or provider determines that a drug should no longer be dispensed and should no longer be taken by the patient. Situations where a prescription may need to be stopped (i.e. aborted) are product recalls, duplicate therapy contraindication, or other therapy issues. This request can be sent throughout the prescription lifecycle.

Stop (Abort) Rx from Network Profile

1. To stop/abort a prescription, highlight the Rx from the Patient Network Profile and select Stop (Abort) Rx from the Extra Functions menu.

2. This will call up the Stop Network Rx form.
a. In the **Effective Date** field, enter the date that the prescription was stopped (i.e. aborted).

b. From the **Reason Code** field, access the dropdown menu and select an available option to explain why the prescription is being aborted.

3. Click **OK** or press **Enter** on the keyboard to execute the **Stop (Abort) Rx**.

The Rx will now have a status of aborted.
Stop (Abort) from Local Patient Profile

1. To stop/abort a prescription, highlight Rx to Stop (Abort) and press I on the keyboard to inactivate.

2. The Inactivate (Rxs) form will open.

3. Click Stop (Abort).

4. Enter a reason for the stop and the click OK.
5. Locally, Rx has a status **Inactive**.

6. On the Network Profile the Rx has a status of **Aborted**.
Add Note

The option to Add Note is used to document additional information concerning a prescription. Notes are primarily used to document error corrections, information change, or new information, but can be used for any reason deemed fit by the pharmacy.

1. To add a note to a prescription, highlight the Rx from the Patient Network Profile and select Add Note from the Extra Functions menu.

2. This will call up the Add Note to Record form.
a. In the **Reason for change** field, select a reason why the note is being added. Enter the note and click **OK** or press **Enter** on the keyboard to add the note to PIP.

3. A blue indicator on the **Profile Summary** screen indicates there are attached notes on this prescription.

4. Retrieve notes that have been added to a prescription from the **Patient Network Profile** by detailing the prescription entry and clicking on the **Notes** tab.
Retract Rx

This function allows you to reverse a Network transaction (e.g. Hold Rx, Release Rx, Stop Rx, etc.) made to prescription entries on a patient’s Network profile. Once an action has been “retracted” it will no longer appear in the result set of subsequent queries made on that prescription.

A transaction must meet three conditions in order to be retracted:

1. The Network user who executed the transaction must be the user who performs the retract.

2. No other Network user has viewed the Patient Network Profile after the transaction was made.

3. The retract must be performed within 24 hours of when the transaction was created.

To retract an Rx, highlight the network prescription entry and select Retract Rx from the Extra functions menu.
A screen will appear listing all the Network transactions that were made to the prescription. Highlight the Transaction Type that needs to be reversed and press Enter or click OK to perform the Retract.

**Extra Functions for Not Dispensed Rxs on the Network**

Not Dispensed prescriptions on the Network (i.e. Rxs filled for “other medications”) have a slightly different Extra Functions menu than “regular” prescriptions.

Highlight the Not Dispensed Rx of interest and call up the Extra Functions menu by clicking on the Extra Functions button, or pressing X on the keyboard.
The options to Add Note, Retract Rx, Detail and Refresh are the same as for regular prescription entries; however, the Update Other Medication option is unique to Not Dispensed Rxs only.

**Update Other Medication**

Highlight a Not Dispensed prescription from the Patient Network Profile and select Update Other Medication from the Extra Functions menu to call up the Update Other Medication form.

- **Status:** Update the status of the Not Dispensed Rx to Active (i.e. the patient is still taking the “other medication”) or Complete (i.e. the patient is finished with the course of the “other medication”).
- **Start Date:** Enter the date that the patient starts taking the “other medication”. The date is defaulted to the current date, but can be manually adjusted.
- **Stop Date:** Optionally enter the date that the patient completes, or is expected to complete, the “other medication” therapy (a blank stop dates indicates that the therapy is to continue indefinitely).

Click OK or press Enter on the keyboard to save information on the Update Other Medication form.

**NOTE:** If a Not Dispensed Rx is updated on the Network, it will not be updated on the local system. And if it is update on the local system, it is not resent to the Network.
Network Options from the Filling Screen

From the F12 Filling screen, you can add supplementary Rx Order/Dispense Information to PIP. Rx Order information is entered one-time only; it is essentially the electronic record of the written script. Dispense information can be entered each time a prescription is filled or refilled. Dispense information is specific to a particular fill in a prescription chain. Entering supplementary Rx Order and/or Dispense information is optional.

1. From the F12-Fill Rx screen, go to Network > Edit Rx Order/Dispense Information.

2. Fill out the Rx Order section of the form:

NOTE: The Rx Order section is only available for New Rxs or Unfilled Rxs.

   a. Note: Enter a note that will apply to the prescription as a whole, as opposed to just one particular fill.
   b. Patient Measurement – Height: Enter the height of the patient in centimeters, feet, inches or meters.
   c. Patient Measurement – Weight: Enter the weight of the patient in grams, kilograms, ounces or pounds.
   d. Treatment Type: From a pre-populated dropdown menu, indicate whether the treatment is ‘as needed’, ‘continuous/chronic’, ‘one time’, or ‘short term/acute’.
e. **Substitution Not Allowed Reason**: From a pre-populated dropdown menu, select a reason why drug substitutions are not allowed for the Rx Order. Options include: ‘Not Specified’, ‘Allergy/Intolerance’, ‘Clinical Trial’, ‘Compliance Concern’, ‘Patient Choice’ or ‘Therapeutic Characteristics’.

**NOTE**: When the **Substitution Not Allowed Reason** is set to **Not Specified**, drug substitutions are allowed for future fills.

3. Fill out the **Dispense** section of the form:

   a. **Note**: Enter a note that is specific to the particular fill and not necessarily to the Rx Order as a whole.

   b. **Substitution Type**: If a drug substitution is being made to the fill, indicate whether it is a ‘Formulary’, ‘Generic’, or ‘Therapeutic’ substitution.

   c. **Substitution Reason**: If a drug substitution is being made to the dispense, indicate the reason for the substitution as ‘Not Specified’, ‘Continuing Therapy’, ‘Formulary Policy’, ‘Out of Stock’, or ‘Regulatory Requirement’.
4. Press **Enter** on the keyboard or click **OK** to save changes made to the **Rx Order/Dispense Information** form.

5. Press **F12-Fill Rx** to fill the prescription.

**Retrieve Rx Order/Dispense Details**

1. Pull up the patient card.

2. Go to Network > Profiles.

3. Log in with your Kroll username and password to access the patient’s Network profile.
4. Highlight the Rx that contains the **Rx Order/Dispense Information** that needs to be retrieved.

5. Click the **Detail** button or press D on the keyboard to bring up the **Medication Order Detail** form.

6. Rx Order/Dispense Information can be recalled from the Medication Order Detail form under the Order, Dispenses and Notes tabs.

**NOTE:** The bracketed number next to **Dispenses, Notes and Issues** tab indicates the number of fills, notes and Issues for the original **Rx Order**.
7. Access **Dispense notes** as follows:

   a. From the **Medication Order Detail** form, click on the **Dispense** tab.
   b. Highlight the appropriate dispense date and click the **Details** button or press **D** on the keyboard to call up the **Rx Order Dispense Detail** screen.

![Rx Order Dispense Detail](image1)

   c. From the Rx Order Dispense Detail screen, click on the **Notes** tab to view the note.

![Note Detail](image2)

   d. Highlight the note and press **D** on the keyboard to call up full note details.
Filling Prescriptions

With PIP integrated in Kroll, all prescriptions must first be sent to the fiscal plan(s) (e.g. SPDP, AHE, ESI, CS, etc.) and then sent to the Saskatchewan Pharmaceutical Information Program (SKPIP) plan for clinical recording; the last ‘plan’ should be listed as ‘Cash’. This sequence of plans allows prescriptions to be billed online, and then logged clinically before passing down any monies to the patient in the form of a cash plan. Keep in mind that the process of fiscal billing to third parties is completely independent from the process of prescription logging on PIP.

**NOTE:** If a patient has an HSN, all dispenses must be sent to the PIP Network. The Exception is Devices which are not sent to the PIP Network. All Rxs not sent to the PIP Network will show up on the Failed Provincial Claims report which is sent to PIP to review.

1. Always enter the patient’s HSN/DIAND number in the HSN field; this will automatically populate the SPDP plan entry. An entry for SKPIP is not necessary as it is created with the SPDP plan and can be seen on the Rx filling screen.
2. Once the HSN/DIAND Number is entered into the patient card, the SKPIP plan will automatically be added to the plan adjudication sequence in the F12-Filling screen right before Cash.

Filling a Prescription to PIP:

1. Fill out the patient, drug, doctor, SIG; dispense information, etc. as usual from the F12 filling screen.
2. Ensure that SKPIP plan is the **LAST** adjudicated plan right before **Cash**.

**NOTE:** Cash is **NOT** considered an “adjudicated” plan.

3. Once all necessary information is entered into the F12 filling screen, click **F12-Fill Rx** or press **F12** on the keyboard to fill the prescription.

**NOTE:** The **Patient Network Profile** is returned by PIP for the first prescription filled after entering the F3-patient card (regardless of whether the Rx is New or Refill). The Profile and Allergy tab should be reviewed for any relevant information. The Network Profile will not be returned for subsequent Rxs.
4. Adjudication to the fiscal plans will be completed first, and then the Rx will be sent to SKPIP for prescription logging.

5. If **Errors** are returned by SKPIP on the **CeRx Adjudication Response** screen, they will need to be **managed** in order to complete the prescription.

![CeRx Adjudication Response Screen](image)

6. The **CeRx Adjudication Response** screen contains three (3) options:
   
   a. **P – View Network Profile**: Selecting this option will prompt the user to enter an optional reason for accessing the profile, and subsequently call up the full patient Network profile.
   
   b. **M – Manage**: Highlight an **error** and press **M** on the keyboard to document the reason (i.e. Management Code) for bypassing an error or multiple errors can be managed at the same time and sent to PIP.
**NOTE**: All errors returned by PIP must be ‘managed’ in order to proceed with filling the prescription.

c. **D – Detail**: Highlight a warning/error returned by the Network and press D on the keyboard to call up the Detected Issue Detail form. Once ALL Errors have been managed, continue from the CeRx Adjudication Response screen by clicking Send Issue Managements or by pressing Enter on the keyboard.
NOTE: Click on Cancel Rx to reverse the prescription.

7. Retrieve the management codes sent with a prescription by accessing the Patient Network Profile. Highlight the Rx entry you want to view management codes for and click Details or press D on the keyboard to call up the Medication Order Detail screen. Click on the Issues tab to view management codes sent for the prescription.

Back dating a Prescription:

1. On the F12 filling screen fill out the Rx details as usual

2. Select Back Date Rx from the Rx menu
3. Enter the date to back date the Rx.

4. On the Filling Screen under the warnings it displays Rx has been backdated to 30/09/14.

5. On the Network Profile it will display the Back date.

NOTE: You cannot backdate a Dispense before the date of creation on the Order.
Putting a Prescription on Hold (Unfilled Rx)

1. Fill out the patient, drug, doctor, SIG; dispense information, etc. as usual from the F12 filling screen.

2. Select Make Rx Unfilled from the side pane.

3. Click F12-Unfill Rx or press F12 on the keyboard to place the prescription on hold. The Unfilled Rx will bypass the fiscal plans and adjudicate through SKPIP for prescription logging.

4. The CeRx Adjudication Response screen will look similar to the following for a successful transaction logged on PIP.
5. An Unfilled Rx on the Patient Network Profile will look similar to the following:

![Patient Network Profile](image)

Cancelling an Rx that has not been Picked Up

1. Call up the local medication profile SHIFT+F3 from the patient card by accessing Profile > All Rxs or pressing SHIFT+F3 on the keyboard from the patient card.

2. Highlight the Rx that needs to be cancelled and click Cancel or press C on the keyboard.

3. If the correct prescription is being pulled up for cancellation, answer Yes to the prompt “Is this the Rx that you want to cancel?”

**NOTE:** Select Cancel and Refill if you are looking to reverse the claim, modify it, and then re-send it.

4. Enter your user initials and password to continue cancelling the Rx if/when prompted.
5. If you are cancelling the first fill of a prescription, the following screen will appear. Select the appropriate option.

![Select an Option](image)

- **Make this Rx Unfilled**: Selecting this option will mark the local and Network Rx entry as “Unfilled” with a status of “Active”. A successful reversal using this option will display the following **CeRx Adjudication Response** screen.

![CeRx Adjudication Reversal Form](image)

- **Filled in Error – Remove from Profile**: Selecting this option will mark the Rx as a “mistake” on the local system and place it into the **SHIFT+F9 – Rxs Filled in Error** profile. The Network entry will be **retracted** and will NOT appear in the **Patient Network Profile**. A successful retract using this option will display the following **CeRx Adjudication Response** screen.

![CeRx Adjudication Reversal Form](image)

**NOTE**: If a **Generic Retract** fails, it will proceed with Abort. User would then need to go to the Rx on the Network profile and stop the Rx Order.
c. Click **OK** or press **Enter** on the keyboard to complete the cancel.

**NOTE:** If an Rx was backdated then cancelled and refilled, the user must manually backdate the Rx.

### Cancelling an Rx that has been Picked Up

When cancelling an Rx that has been picked up, there are two options to choose from:

1. **Cancel and Rebill:** Allows you to only make billing changes.

2. **Cancel Rx:** Allows you to reverse an Rx and copy to a new number to make clinical changes (Qty, Drug, Sig, etc.)
Cancel and Rebill

1. Select **Cancel and Rebill** from the **Confirm Cancel** screen. The login screen appears.

![Confirm Cancel Screen](image)

- **Cancel and Rebill**: This will allow you to make billing changes only (i.e. plans and copays).
- **Cancel Rx**: This will cancel the Rx and allow you to specify if the inventory will be discarded.

**Note**: If the Rx was filled in the past, the Rx and pickup will be automatically backdated.

Login with your user credentials.

![Login Screen](image)

2. The pickup and Dispense are reversed.

![Reverse Dispense Screen](image)

3. Add or remove a plan and by clicking **F12**, the dispense and pickup are sent automatically.

**NOTE**: If the Rx was filled in the past, the Rx and pickup will be automatically backdated.
Cancel Rx

1. Select **Cancel Rx** from the **Confirm Cancel** screen.

![Confirm Cancel]

A pharmacist has to login and authorize the cancel that was previously picked up.

![Please authorize the cancel of this picked up Rx]

2. You will be prompted to select one of two options. If you are going to discard the medication, select **‘Yes, Medication will be discarded’** or if the patient is still using it or the medication has not left the store, select **‘No, this patient will be using it, or it has not left the store’**.

![Select an Option]

If you select **‘Yes, Medication will be discarded’**, you will be prompted to login with your initials.
- Enter your initials and click OK.

- Select if the Rx should be made **Unfilled** or **Removed** from the profile.

If you select **Unfill**, the pickup is retracted and the dispense is reversed.

When you select ‘**No, this patient will be using it, or it has not left the store**’, you will be prompted to login with your initials.

- Enter your initials and click OK.
• Select **Make this Rx Unfilled** or **Filled in Error - Remove from profile**.

![Select an Option](image)

• If you select **Filled in Error - Remove from profile**, the retract pickup and generic retract are successful.

![Generic Retract](image)

• The Filled in Error Rx is no longer on the Network Profile.

**NOTE**: When Reversing an Rx that has been picked up and consent has not been given, you will need to perform the following:

3. **Click Cancel**.

![Detected Issues](image)
4. Select **Save the message to be resent later**. This will add it to the **Rxs in Progress** workflow to be sent once consent has been given.

5. Go to patient and add consent.

6. Go to **Rxs in Progress** and click **Get work**. This will resend the retract pickup and retract dispense.
Cancel Rx and refill an Rx that has been discontinued

Users can correct information on a dispense after the prescription has been discontinued and re-send it to PIP and any relevant adjudicators for up to 62 days from the original dispense.

1. Locate in the local patient profile the inactivated (Discontinued Rx) you want to do a cancel and refill on.

2. Type C on keyboard to cancel

3. Select Cancel and Refill.

4. Enter your login credentials.
5. Select **Clinical Changes (Drug, Doctor, Qty, Sig)**.

6. Reverse Dispense is successful. Click **OK**.
7. Make adjustments to the Rx. There will be a warning that the Rx is Inactive. Click **F12** to Fill the Rx.

![Dispense successful screenshot](image)

Dispense is successful
Filling an Rx for a Device

Devices are considered non-drug products such as diabetic strips, lancets, Aerochambers, compression stockings, etc. When a prescription is filled for a device it is NOT sent to PIP. It bypasses PIP and carries on to the ADAPT financial billing portion. Fill an Rx for a device as follows:

1. Bring up the drug card for a device by doing an F5 drug search.
2. Place a checkmark next to the Device flag.
3. Press Enter on the keyboard or click Save to save changes made to the drug card.
4. Press F12-Fill Rx to fill a prescription for the device.

NOTE: If the drug being filled has the Device flag ON and the SKPIP plan is included in the plan sequence, the system automatically drops the SKPIP plan and a warning message will appear stating ‘The clinical plan was removed for this device’.
5. The prescription will bypass PIP as a result of the Device flag. As such, when you access the Patient Network Profile, the **Device Rx** will appear with a yellow-local data-bar because it only exists locally on Kroll.

---

**Filling a Mixture Rx**

When adjudicating a mixture to SKPIP, DIN numbers are not sent; instead the ingredient names are logged on PIP.

Since DINs are not sent to PIP, the addition of SKPIP pseudo DINs are NOT required and mixtures will be added into Kroll in the same manner as always.

The following screen shot depicts a mixture for Hydrocortisone Powder 1% in Clotrimaderm Cream:
**NOTE:** There are NO pseudo DINs entered for the SKPIP plan because NO DINs are being sent. (Pseudo DINs for fiscal plans are entered in the same manner as always).

A prescription for a mixture will be entered and filled as usual:
Successful adjudication to SKPIP for clinical recording will result in a **CeRx Adjudication Response** screen similar to the following:

![CeRx Adjudication Response](image)

To view the logged mixture prescription from PIP, go back to the **F3**-patient card and access **Network > Profile** and log in with your user initials and password.

![Patient Network Profile](image)

Highlight the mixture prescription and press **D**, or click **Detail** on the bottom of the screen to call up the **Medication Order Detail** form which displays the particulars of the mixture prescription.
**NOTE:** The **Order Details** do not list any DINs for the medication or ingredients of the mixture. The active ingredient is listed under the tab **‘Medication’**.

Click the **Ingredients** tab to view ingredient(s) of the mixture:
Transferring an Rx to another Pharmacy

When you are transferring an Rx to another pharmacy, use the standard Transfer Out process from the Extra Functions button of the local patient profile. When a transfer out is performed, if the targeted pharmacy is out of province, a message will be sent to PIP and the network profile will immediately reflect the new targeted pharmacy.

<table>
<thead>
<tr>
<th>Pharmacy Targeted To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: DOP Pharmacy</td>
</tr>
<tr>
<td>City: Regina</td>
</tr>
<tr>
<td>Prov: SK</td>
</tr>
<tr>
<td>Postal: S4S 6X6</td>
</tr>
<tr>
<td>Phone: (306) 787-3421</td>
</tr>
<tr>
<td>ID: CPN.00027204.SK.PRS</td>
</tr>
</tbody>
</table>

If the targeted store is within the province of Saskatchewan, then no message is sent. The network profile will not reflect the new targeted pharmacy until that pharmacy performs a dispense against the order.
Filling an Rx using an Natural Product Number (NPN)

A Natural Product Number (NPN) is assigned by Health Canada to a product whose manufacturer has submitted enough human evidence to support the health claims they have declared. Natural health products that are dispensed to patients can be recorded on PIP through Kroll as follows:

1. In the F5-Drug screen for the natural health product, go to the Plans tab and ensure that there is an entry for SKPIP with the DIN type set to DIN.

   -OR-

   In the F5-Drug screen for the natural health product, ensure that the main DIN type is set to DIN

2. Enter the NPN number listed on the product in the DIN field.
3. Click **Save** or press **Enter** from the drug card to save any changes that were made.

4. Start a prescription and fill out the patient, drug, doctor, SIG and dispense information for the prescription as usual where the drug is the natural health product.

5. Usually natural health products are not covered by third parties so the plan sequence will be SKIPP and then CASH. If the natural health product is covered by a third party payer, the sequence will be ‘fiscal’ plan, SKIPP, and then CASH.

6. Click **F12-Fill Rx** or press **F12** on the keyboard to fill the NPN prescription. A successfully logged Rx for a natural health product will elicit the following **CeRx Adjudication Response** screen.
Filling an Rx for an Animal

Prescriptions filled for pets are **NOT** recorded on PIP. Pets in the database must have an animal indicator turned **ON** in order to successfully fill prescriptions.

**NOTE:** All prescriptions filled for an animal will bypass PIP and be stored locally only. Animal-patients do not need a HSN number and will NOT have a Patient Network Profile.

Mark a pet as ‘**animal**’ in Kroll as follows:

1. Bring up the patient card for the animal using an **F3-Patient** search.
2. Go to the **General** tab of the patient card.
3. Change the **Patient Type** to **Animal** and provide and optional descriptor (e.g. cat, dog, etc.).

4. Click **Save** or press **Enter** on the keyboard to save changes made to the patient card.
5. Proceed to fill a prescription for the animal that will bypass PIP.

Filling an Rx for Out-of-Provience Patient

Pharmacies will fill ‘**out of province**’ patient prescriptions as usual by ensuring that the SKPIP plan is not a part of the Rx. These out of province patient prescription will show up on the Patient Network Profile as LOCAL Rx only.
Filling an Rx for an Out-of-Province Doctor

If you are filling an Rx for Out of Province Doctor, a low priority warning will be returned from PIP. This does not need to be managed.

![Image of CeRx Adjudication Response window showing a successful dispense Rx]

![Image of (Network) Detected Issue Detail window showing a warning for a business constraint violation]

*The prescriber has no active registrations.*

[pin.domain.request.dispense.prescription.provider.registration.inactive : 2012-Aug-03 17:57:59.128 GMT]
Filling an Rx for Stock Transfers

Pharmacies filling an Rx for Stock Transfers should follow the same procedure as filling for an Rx by filling out the **F12 – Fill Rx** screen and going to **Rx > Extra Functions > Stock Transfer** to indicate that the Rx is a stock transfer. When this flag is on, the Rx will bypass PIP.

The **Stock Transfer Rx** will show up on the ‘Failed Provincial Claims Report’ as **SK Patient has no HSN**.

Filling an Rx for a Drug not on PIP

New drugs will sometimes not be on PIP. Pharmacies should remove the PIP plan on these Rxs and continue filling. These Rxs will then show up on the Failed Provincial Claims Report. They should then call Kroll Support desk to report who in turn will call PIP help desk.

Filling an Rx that is rejected by PIP

If a Dispense is rejected, select **Skip this Plan** to ensure the Rx shows up on the **Failed Provincial Claims Report** with the proper error message.

Refilling an Rx without PIP

If an Rx was filled previously without the PIP plan, users will need to add this plan manually on a refill.
Prescription Vial Labels

The PIP Rx order and Dispense number will print on the vial labels. When you need to troubleshoot a prescription with the PIP helpdesk, the Rx order number will be required. If you do not have the original label, you can bring the Rx up in modify mode and under Labels > Labels Preview to see PIP Order # and PIP DISP#.

The Rx Order Number can also be seen on the Patient Network Profile as PIP Order#.

The PIP DISP # will be displayed under the Dispenses tab.
Indications

Sending Indications to the Network

In medicine, an indication is defined as a condition which makes a particular treatment (i.e. drug) or procedure advisable. Pharmacy users can add the indication of a drug from the F12-Filling screen and send it to PIP for clinical recording as follows:

1. Fill out the patient, drug, doctor, SIG and dispense information on the F12-Filling screen.
2. Click on the Indications tab located on the lower left of the F12-Filling screen.
3. Click Ins or press Insert on the keyboard to add an indication for the drug listed in the prescription.
Retrieving Indications on the Network

Indications can be retrieved from the Patient Network Profile as follows:

1. From the patient card, go to **Network > Profile** and log in with Kroll initials and password.

2. From the **Select Profiles to query** form, place a check mark next to **Profile** and click **OK**.

3. Enter an optional reason for accessing the patient profile and click **OK** or press **Enter** on the keyboard to continue.

Highlight the prescription you wish to view indications for and click **Detail** or press **D** on the keyboard to call up the **Medication Order Detail** screen.

4. Click on the **Indications** tab or press **CTRL+C** on the keyboard to view the logged indications.
Prescription Pickup

The Saskatchewan Health Information Network (SHIN) requires pharmacies to log when a prescription is physically picked up from the pharmacy. This information is entered in Kroll and sent to PIP for clinical recording.

It is important to note that recording prescription pick-ups is a crucial part of the prescription lifecycle. If an Rx is not marked as “picked up” and the pharmacy goes to fill another dispense against the prescription, PIP will return a warning “This prescription has one or more dispenses that have been filled but not picked up”. In addition, the ‘remaining quantity’ for a prescription listed on the Pharmacy Network is not adjusted until the Rx is marked as picked up.

**NOTE:** Prescriptions that are UNFILLED, NOT DISPENSED, INACTIVE or CANCELLED do not need to be marked as ‘picked up’ on PIP. Once an Rx is filled and ‘picked up’ on PIP, if the pickup needs to be retracted; the entire Rx needs to be retracted and then refilled without the pickup being completed.

Automatic Pickup

You can send pickups at the time of fill. Please contact Kroll to set up this Workflow.

Manual Pickup

1. From the Alt-X Start screen, select F10-Pickup.
2. Enter the name of the patient for the Rxs that are to be picked up.
3. A list of Rxs waiting for pickup will be displayed. The user can choose to pick up all the Rxs that are listed or uncheck the Rxs that are not being picked up at this time. Then click on Pickup 3 Items.

4. Select the person picking up the Rxs. It defaults to the patient. Once you have selected the person picking up the Rx, click on Edit or press Enter on the keyboard.

5. If the Rxs are being picked by someone other than the patient, select the Relationship of that person with the patient and then click Confirm.
6. A list of Rxs that are being picked up is displayed for confirmation. Click on **Confirm 3 Items**.

<table>
<thead>
<tr>
<th>Rx: 1002267</th>
<th>Kroll, Co</th>
<th>Apo-Oxaprozin 800mg</th>
<th>$16.56</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx: 1002264</td>
<td>Kroll, Co</td>
<td>Plendil 10mg</td>
<td>$17.87</td>
</tr>
<tr>
<td>Rx: 1002266</td>
<td>Kroll, Co</td>
<td>Toradol 10mg</td>
<td>$23.50</td>
</tr>
</tbody>
</table>

When the pickups are successful, you are returned to the pickup screen to enter a new patient if required.

**Retrieving Picked Up Status from the Pharmacy Network**

1. Bring up the Patient card using the **F3-Patient** search.
2. Go to **Network > Profile** and log in with your Kroll username and password.
3. Enter an optional reason for accessing the profile.
4. From the **Profiles** tab, prescriptions that are picked up will have a date listed in the **Picked Up** column.

5. To obtain more information on the pickup, highlight the prescription of interest and press **D** on the keyboard to bring up the **Medication Order Detail** form.
6. The picked up status are also displayed under the **Dispenses Tab**.

![Kroll Pharmacy Network](Image)

**Undo Pickups**

This section outlines the process for undoing a pickup.

1. From the **Pickup** patient search screen or the **Alt-X Start** screen, select **Utilities** from the menu bar located at the top of the screen and select **Undo Pickup** or press (**Ctrl + F10**) on the keyboard.
2. The Undo Pickup screen appears. Highlight the Delivery Order that needs to have the pickups retracted and click Select.

3. The Undo Confirmation screen will appear. Click Confirm Undo.

4. A Login screen appears with a warning to ensure that you are about to finalize the undo of a pickup. Enter your initials and password and click OK to perform the Undo.

5. The retract pickups are sent to the Network. Once completed, the Undo Pickup screen
displays again. Select Close to exit the screen.

6. The Rxs are now back in the waiting for Pickup queue.
Reports

Patient Network Audit Report

The Patient Network Audit Report provides a listing of all network accesses for a given time period broken down by patient. The report contains supplementary information on when the patient’s profile was accessed, who it was accessed by, the reason for access if available, and the type of access (e.g. CeRx Profile Access).

1. From the Alt-X Start screen, go to Reports > Administration > Patient Network Audit Report.
Failed Provincial Claims Flat File Report

The **Failed Provincial Claims Flat File Report** captures all prescriptions that are NOT clinically recorded on PIP through Kroll adjudication. For example, the report will capture prescriptions filled for devices, out-of-province patients, animals, stock transfers, etc. The report is a requirement of HISC (Health Information Solutions Centre) and its purpose is to ensure that there are no gaps in the clinical recording of prescriptions filled by the pharmacy.

This report will run automatically at the beginning of every month (for the previous month’s claims). This process will be set up in the Kroll scheduler. However, the pharmacy should manually print this report towards the end of every month in order to correct any claim errors so that those claims will no longer be exceptions and not included in the report when it is run automatically.

To generate a report manually, go to **Network > Generate Failed Claims Report**.

Select an appropriate date range (typically “This Month” if you are doing this near the end of the month) and click **Preview**.

If you need a hardcopy, print a copy of the report from the resulting report preview.

To send to PIP manually, click **Run**.
Prior to running the report generator, you will see the following warning:

Sample Failed Provincial Claims Report:
What Happens When PIP Goes Down

In the event the PIP server goes down, Kroll will queue all claims (i.e. allergy adds, Rx orders, Rx dispenses, updates, etc.) in the order of creation so that they can be sent when PIP is up again.

No new claims for a particular patient can be sent to PIP until all queued claims for that patient have been sent to PIP. A prior queued claim may have an impact on the results of another claim that is sent down (e.g. an allergy add request must be sent before more dispenses are sent because that may affect the outcomes of the DUR processing for those subsequent dispenses).

When PIP is down, claims are queued in order of creation in the following area:

1. Go to **F9 - Workflow > Pending Adjudication**.
2. When PIP is up again, users can click on **Send/Review All** to send everything at once or they can select **Send/Review for Current Patient** to be sent to a particular patient only.

**NOTE**: The exception to this is when the Pharmacy marks PIP as down when they know PIP will be down for a period of time. If an allergy is added when the network is down, it is added locally only. Remember to sync allergies to the network when the network is available.
Printing Labels for Dispensing when PIP is Down

When PIP is down, users can adjudicate claims to the fiscal plans first, print labels for dispensing, and then place the Rx in a Network queue for adjudication to SKPIP once the PIP server is back up.

1. The plan sequence should have the fiscal plans listed first, then the SKPIP plan, followed by the Cash plan.

2. Clicking **F12-Fill Rx** or pressing **F12** will initiate adjudication of the prescription.
NOTE: If the system attempts to access the Patient Network Profile when PIP is down (because this is the first Rx being filled after pulling up the patient card), the following message will appear:

```
1-(local):PharmacySK-NewRx-Kroll, AA

There were errors getting the following profile information:
Error:Profile: Unable to connect to the remote server
Error:Allergies: Unable to connect to the remote server

OK
```

3. Click OK.

4. The Rx will go through the fiscal plans and will be paid. Here is an example for AHE and ESI.
5. Once fiscal adjudication is complete, the prescription will be sent to SKPIP for clinical recording. Since the PIP server is down, the claim transmission will fail.

![Image showing Celox Adjudication Response]

The claim transmission failed because: Unable to connect to the remote server

The claim transmission failed. Do you want to:
- Retry claim
- Back to the Rx
- Send Later
- Cancel Rx

6. Select the option **Send Later**; labels will print automatically, and the prescription will be queued.

7. Once the PIP server is back up, send to SKPIP.
Kroll Helpdesk Information

Head Office – Toronto

220 Duncan Mills Road Suite 201
Toronto, Ontario
M3B 3J5
Tel: 416-383-1010
Toll Free: 1-800-263-5876
Fax: 416-383-0001
support@kroll.ca

Western Canada – Edmonton

9622 – 42nd Avenue NW Suite 313
Edmonton, Alberta
T6E 5Y4
support@kroll.ca

Eastern Canada – Dartmouth

33 Ochterloney Street, Suite 260
Dartmouth, Nova Scotia
B2Y 4P5
support@kroll.ca